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Micro Focus Visual COBOL 2.2 Update 2 for
Visual Studio Release Notes

These release notes contain information that might not appear in the Help. Read them in their entirety
before you install the product.

Product Description

Visual COBOL enables you to develop COBOL applications within Microsoft Visual Studio. You use the
Visual Studio integrated development environment (IDE) to edit, compile and debug COBOL applications.
The IDE provides all the functionality to manage projects and build applications.

The product is available in the following variants - Visual COBOL for Visual Studio 2010, Visual COBOL for
Visual Studio 2012 and Visual COBOL for Visual Studio 2013 - each one of which target a different version
of the deployment product:

e COBOL Server - the deployment environment for COBOL applications created with Visual COBOL for
Visual Studio 2010 or Visual COBOL for Eclipse

e COBOL Server 2012 - the deployment environment for COBOL applications created with Visual COBOL
for Visual Studio 2012

* COBOL Server 2013 - the deployment environment for COBOL applications created with Visual COBOL
for Visual Studio 2013

f Note:

This document contains a number of links to external Web sites. Micro Focus cannot be
responsible for the contents of the Web site or for the contents of any site to which it might link.
Web sites by their nature can change very rapidly and although we try to keep our links up-to-date,
we cannot guarantee that they will always work as expected.

» Heartbleed Update - The OpenSSL library used in this product has been updated to the latest
version, 1.0.1i, to fix various vulnerabilities.

» Visual COBOL now includes support for creating Web service and Enterprise Java Bean
applications using the Interface Mapping Toolkit (IMTK) in conjunction with Enterprise Server. If
you are upgrading to this release from an earlier version of Visual COBOL, you may need to apply
for a new authorization code in order to access the functionality - please contact Micro Focus
SupportLine to receive an updated authorization code. Note that the Visual COBOL Personal
Edition license does not support the IMTK functionality.

* The Data File Tools utility is no longer distributed as a stand-alone AddPack and is now installed
with Visual COBOL.

» Starting with the next product release, Micro Focus will no longer support Visual COBOL for Visual
Studio 2010.

i Note:

v+ Important: Application executables that were compiled using earlier Micro Focus products must be
=*' recompiled from the sources using Visual COBOL.

Micro Focus Visual COBOL 2.2 Update 2 for Visual Studio Release Notes



Installation

System Requirements

Hardware Requirements

Visual COBOL has the following requirements in addition to the requirements of Microsoft Visual Studio.
See the Visual Studio documentation for details of the Microsoft requirements.

The disk space requirements are, approximately:

Platform Visual COBOL Sentinel RMS License Manager
x86 Windows platforms 250MB 25MB
x64 Windows platforms 350MB 25MB

Note: This includes the space needed to cache information locally so that you can modify the
installation without the original source media.

Operating Systems Supported

Note: If you are using Visual COBOL on a 64-bit operating system, you can produce either 32-bit or
64-bit applications.

For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.

y Note:

* Visual COBOL for Visual Studio 2012 or 2013 is not supported on versions of Windows earlier
than Windows 7.
» The Enterprise Server feature is not supported on Windows XP.

Software Requirements

Visual Studio IDE
Visual COBOL requires:

« A full version of Microsoft Visual Studio 2010 or 2012 or 2013 Premium, Professional, or Ultimate
edition, or the respective version of Microsoft's Visual Studio Integrated Shell.

In addition, Microsoft's Visual Studio 2010 Service Pack 1 (SP1) is required if you are installing Visual
COBOL for Visual Studio 2010 - you can download it from the Microsoft Download Center.

Your preferred edition of Microsoft's Visual Studio must be installed before you start the Visual COBOL
installation. If Visual Studio is not installed, the Visual COBOL setup file installs the Visual Studio Shell
(this requires that your machine is connected to the Internet if you are installing Visual COBOL for
Visual Studio 2010).

If you are installing Visual COBOL for Visual Studio 2010 and your machine cannot be connected to the
Internet, you need to download Microsoft's Visual Studio 2010 and the Visual Studio 2010 Service Pack

Installation | 5
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1 (SP1) on a machine that has Internet connection, and then copy the installer to your machine. Visual
Studio 2010 and SP1 must be installed before you install Visual COBOL.

i Note:

Microsoft Visual Studio Express Edition is not supported.

» The Visual Studio 2013 Connected IDE experience is not available with the 2013 Shell.

* You can download the Visual Studio Integrated Shell from the Microsoft Download Center. If
you choose to install the Shell, ensure you run the installer to complete the installation - run
vsintshell.enu.exe from the location where you installed the download.

* Microsoft Windows SDK is required if you are using the Visual Studio Shell. See the Microsoft
Download Center and search for Windows SDK.

« Microsoft .NET Framework 4.0. This is included with the above versions of Visual Studio.

* Microsoft NET Framework 4.5. This is included with Visual Studio 2012.

* Microsoft .NET Framework 4.5.1. This is included with Visual Studio 2013.

i Note:

« The Visual Studio feature project round-tripping requires Visual Studio 2010 Service Pack 1 is
required if you are using Visual COBOL for Visual Studio 2010 and Visual COBOL for Visual
Studio 2012 or Visual Studio 2013 on the same machine.

» When building a native COBOL project that contains resources, you must replace the
cvtres._exe in the bin and bin64 directories of your Visual COBOL installation with the version
of the file which gets installed with Visual Studio 2010 SP1. You can download Service Pack 1 for
Visual Studio 2010 from the Microsoft Download Center.

Internet Explorer 10

Internet Explorer 10 (IE 10) is required by the installation of Visual Studio 2013. If you are installing Visual
COBOL on a machine that has no Visual Studio 2013 installed, the setup file installs Visual Studio 2013
Shell provided that IE 10 is installed beforehand. You can download IE 10 from Microsoft's Web site.

IIS Express

IIS Express is required if you want to use the Web development tools. You can download IIS Express from
the Microsoft Download Center.

Other Requirements

v+, Important: This release requires version 10000.2.990 or later of the Micro Focus licensing software.
~*' For local servers, you do not need to install it separately, as the setup file installs a new Visual
COBOL client and a new licensing server on the same machine.

If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus Licensing System Administration tool.

You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com.

Additional Software Requirements

To ensure full functionality for some Visual COBOL features, you might be required to obtain and install
additional third-party software in addition to the prerequisite software installed automatically by the Visual
COBOL setup file. The following information specifies the third-party software required for each feature.

e COBOL on Windows Azure on page 7
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« Java Development Kit (JDK) on page 7

« Consolidated Trace Facility on page 7

« Database Access on page 7

» Database Access - COBSQL (Pro*COBOL) on page 8
« Database Access - OpenESQL on page 8

« Database Access - DB2 ECM on page 9

* Windows Forms on page 10

« XML Extensions on page 10

COBOL on Windows Azure
Back to Top

Windows Azure requires additional software. See the Microsoft Windows Azure web site for a full list of the
required software, but the following is a summary of the main prerequisites:

«  Windows 7, Windows Vista® SP1 or higher, or Windows Server® 2008
« Visual Studio's Visual Web Developer feature
« Windows Azure Tools version 2.1 for Visual Studio - this includes the Windows Azure SDK

« Internet Information Services (IIS) 7.0 - this must be installed and enabled, with ASP.NET, which is not
enabled by default

Java Development Kit (JDK)
Back to Top

Native COBOL and  Oracle's Java Platform, Enterprise Edition (Java EE) 6 or Java 7 is required to

Java Interoperability execute COBOL JVM code and for native COBOL and Java interoperability. The
earliest supported release of Java 6 is 1.6 Update 27. You can download Oracle's
Java EE from Oracle's Web site and install it anywhere on your machine.

Compiling Java Either the IBM or the Oracle Java Development Kit (JDK), version 1.5 or later, is
required for compiling Java.
Interface Mapping Restriction: This feature applies only when the Enterprise Server feature

The JDK is required for generating Java interfaces from the Interface Mapping
Toolkit or the imtkmake command.

Java Beans Your Java client needs to be compiled with JDK 1.6 or greater.

EJBs Use the same JDK vendor and version that is used by the
application server.

After installing the JDK, you need to set up your Java environment.

Back to Top

Consolidated Trace Facility

e The Microsoft .NET Framework 2.0 or later is required for the CTF Viewer. It is available from the
Microsoft .NET downloads area.

Database Access
Back to Top

Before you can use Visual COBOL to develop and deploy SQL applications that use COBSQL, DB2 ECM,
or OpenESQL, ensure any third-party software prerequisites are installed and the environment is set

properly.

Installation
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Database Access - COBSQL (Pro*COBOL)

Back to Top

i Note: COBSQL (Pro*COBOL) is supported for native COBOL only.

Availability

Feature/Platform 32-bit 64-bit
x86-64 running X X
Windows

XA Switch Module  When the Enterprise Server feature is enabled, the Oracle XA switch module is

Certification of
RDBMS

provided for COBSQL (Pro*COBOL), and is available on the same platforms as
are indicated in the Availability section above.

Certification of RDBMS precompilers with Micro Focus products is the
responsibility of the RDBMS vendor, rather than Micro Focus. Certification

Precompilers for information can be found within the relevant Oracle documentation. If you have an

Native COBOL

Preprocessors

Compiling

Back to Top

Oracle MetaLink account, document # 43208.1 provides details of all language
compilers certified by Oracle for use with their precompilers.

COBSQL supports the following database preprocessors:

« Sybase Open Client Embedded SQL/COBOL Version 11.1 or later
e Oracle Pro*COBOL Version 11.1 (11gR1) or later
* Informix Embedded SQL/COBOL Version 7.3 or later

On x86 and x86-64 platforms, when compiling with COBSQL for use with Oracle,
do not use the COBSQL directive option NOMAKESYN, since this directive results
in COMP host variables, and on Intel platforms these are incompatible with the
native byte order expected by Oracle.

Database Access - OpenESQL

Availability

XA Switch
Modules

Native
COBOL
and .NET
Managed
COBOL

NET
Managed
COBOL

Feature/Platform Native COBOL 32-bit Native COBOL 64-bit

x86-64 running Windows X X

When the Enterprise Server feature is enabled, the ODBC One-phase Commit and the
SQL Server XA switch modules are provided and are available on the same platforms as
are indicated in the Availability section above.

To build the SQL Server XA module, you must have the Windows Software Development
Kit (SDK) installed for your version of Windows.

e OpenESQL supports access to relational databases using ODBC 3.0-compliant
drivers

» Refer to your driver vendor's documentation to determine whether your driver is
suitable for use with OpenESQL

e OpenESQL has been tested against the following ADO.NET data providers:

e Microsoft provider for SQL Server
» Microsoft provider for Oracle
- IBM DB2
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SQL CLR
Integration

SQL CLR
Integration

* Oracle Data Provider for .NET (ODP.NET)
* OleDb
e Managed ODBC .NET providers

» Dynamic SQL using the SQL Descriptor Area (SQLDA) is not currently supported for
OpenESQL applications compiled with the SQL(DBMAN=0ODBC) directive.

The following software is required to use the SQL CLR integration feature, which is
specifically for the development and deployment of COBOL stored procedures under
Microsoft SQL Server.

Projects based on the SQL CLR Database Project template require:

» Visual Studio Professional 2010, Premium 2010, or Ultimate 2010
* SQL Server 2008 R2 targeting .NET CLR v2.0 frameworks (2.0, 3.0, 3.5)

Projects based on the SQL Server Database Project template require:
» All of the following:

* Visual Studio Shell 2010, Visual Studio Professional 2010, Premium 2010, or
Ultimate 2010
e Subsequent installation of:

* Visual Studio 2010 SP1 (for any previously installed edition of Visual Studio
2010)
* Microsoft SQL Server Tools (SSDT SDK)
* Any of the following:

e SQL Server 2008 R2 targeting .NET CLR v2.0 frameworks (2.0, 3.0, 3.5)

e SQL Server 2012 targeting .NET CLR v4.0 framework (4.0, 4.5) or .NET CLR v2.0
frameworks (2.0, 3.0, 3.5)

* SQL Server Azure targeting .NET CLR v4.0 framework (4.0, 4.5) or .NET CLR
v2.0 frameworks (2.0, 3.0, 3.5)

The following software is required to use the SQL CLR integration feature, which is
specifically for the development and deployment of COBOL stored procedures under
Microsoft SQL Server.

Projects based on the SQL Server Database Project template require:
» Either of the following:

» Visual Studio Shell 2012 and Microsoft SQL Server Tools (SSDT SDK)
* Visual Studio Professional 2012, Premium 2012, or Ultimate 2012

* Any of the following:

e SQL Server 2008 R2 targeting .NET CLR v2.0 frameworks (2.0, 3.0, 3.5)

* SQL Server 2012 targeting .NET CLR v4.0 framework (4.0, 4.5), or .NET CLR
v2.0 frameworks (2.0, 3.0, 3.5)

* SQL Server Azure targeting .NET CLR v4.0 framework (4.0. 4.5) and also .NET
CLR v2.0 frameworks (2.0, 3.0, 3.5)

~ Important: The SQL CLR Database project template is not supported with Visual
~—' Studio 2012. Projects based on the SQL CLR Database project template are
automatically upgraded to use the SQL Server Database project template when
opened in Visual COBOL for Visual Studio 2010.

Database Access - DB2 ECM

Back to Top

Installation

9



Availability Feature/Platform 32-bit 64-bit

x86-64 running X X
Windows

XA Switch Module When the Enterprise Server feature is enabled, the DB2 XA switch module is
provided and is available on the same platforms as are indicated in the
Availability section above.

Certification of Certification of RDBMS precompilers with Micro Focus products is the
RDBMS responsibility of the RDBMS vendor, rather than Micro Focus. You can find IBM
Precompilers for document certification information for DB2/COBOL applications within the IBM
Native COBOL Information Center for DB2, in the topic Support for database application

development in COBOL.
Preprocessor DB2 ECM supports the following database preprocessors:

« |BM DB2 LUW Version 9.5 or later
+ |BM DB2 Connect Version 9.5 or later

Windows Forms

Back to Top

» Microsoft Internet Information Service (11S) is also required for generating Windows Forms test clients.

XML Extensions

Back to Top

« XML Extensions has the same requirements as Visual COBOL. Both 32-bit and 64-bit versions are
available. See the XML Extensions for Visual COBOL, available from the Visual COBOL product
documentation section of the Micro Focus SupportLine Web site for more details.

< Additionally, XML Extensions may be used in conjunction with Terminal Server.

Installing Visual COBOL for Visual Studio

Downloading the Product

1. Use the download links in your Electronic Product Delivery email.

For more information follow the links for the installation instructions and the End User License
Agreement.

You can download Visual COBOL for Visual Studio 2012 or 2013 from the Micro Focus SupportLine Web
site and from the Product Updates section.

Product Co-Existence

* Visual COBOL and COBOL Server cannot coexist on the same machine.

« Visual COBOL and Enterprise Developer cannot coexist on the same machine regardless of which IDE
(Visual Studio or Eclipse) you install.

« Visual COBOL is available in different IDE variants, each one of which is targeted by one specific
variant of the development product:

10 | Installation



e COBOL Server - the deployment environment for COBOL applications created with Visual COBOL
for Visual Studio 2010 or Visual COBOL for Eclipse

* COBOL Server 2012 - the deployment environment for COBOL applications created with Visual
COBOL for Visual Studio 2012

* COBOL Server 2013 - the deployment environment for COBOL applications created with Visual
COBOL for Visual Studio 2013

You can only deploy applications to the specific variant of COBOL Server that is targeted by the Visual
COBOL variant used to build the applications. For example, if you build your application using Visual
COBOL for Visual Studio 2012, you can only deploy the target files to COBOL Server 2012. The
application will not run in COBOL Server or COBOL Server 2013.

Installation restrictions and requirements

Before starting the installation you should consider the following:

Visual COBOL and Enterprise Developer cannot coexist on the same machine.

If, when you install Visual COBOL for Visual Studio 2010, the machine does not have Microsoft Visual C
++ 2010 Redistributable Runtime already installed, it is installed as required by Visual COBOL. The
installation of Microsoft Visual C++ 2010 Redistributable Runtime adds a number of .dl1 files, without
digital signatures, into the winsxs directory.

If, when you install Visual COBOL for Visual Studio 2012 or 2013, the machine does not have Microsoft
Visual C++ 2012 or 2013 Redistributable Runtime already installed, it is installed as required by Visual
COBOL. The installation of Microsoft Visual C++ Redistributable Runtime adds a number of .d11 files,
without digital signatures, into the winsxs directory.

If you are installing this as an upgrade, make sure that none of the product files are in use when you
start the installation. Also, the Visual Studio Help Viewer must not be opened.

You need to be logged in with a user-ID that has write access to the registry structure under
HKEY_LOCAL_MACHINE, HKEY_CLASSES ROOT, and HKEY_CURRENT_USER so the installation
software can set the environment appropriately. You also need to be logged on with Administrator
privileges.

Before installing this product, make sure that any existing Micro Focus Directory Server (MFDS) or
CCITCP2 Windows service (on Windows) from an existing product is stopped and uninstalled. On
Windows, do this as follows:

1. Stop the MFDS and CCITCP2, using either the Windows Service Management Console GUI
(services.msc) or from a command line prompt by typing:

net stop mf_ccitcp2

Only one instance of the MFDS or CCITCP2 service can run on a Windows machine.
2. Uninstall the MFDS or CCITCP2 service.

For MFDS, from a command line prompt enter: mfds -u
For CCITCP2: ccitcp2 -u
To run an earlier version of MFDS as a service after you have installed a later version:

1. Stop and uninstall the MFDS service, as described above.
2. Reinstall the earlier version, as follows:

a. Open a Visual COBOL command prompt.
b. Install the service. Enter the following command: mfds -i
c. Start the service. Enter the following command: net start mf_ccitcp2

Installation
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MFD

Note: The two versions use different paths for environment and registry values, so the list of
configured enterprise servers might be different depending on which version has been started,
since, by default, different MFDS data repositories are used.

S 5.1 and later are able to import or use Enterprise Server configuration data generated by earlier

versions of MFDS, but 5.0 or earlier versions of MFDS might not be able to read data generated by later
versions.

It is possible to run MFDS from a command prompt ("mfds") rather than as a service, but by default the
"mfcobol” port is used (86) and this can only be used by one process at a time

Installing as an Upgrade

This release will update existing installations of Visual COBOL 2.2.

» Before installing this release as an upgrade to an existing installation of the previous version 2.2 of the
product, you must uninstall any HotFixes of 2.2. This is to avoid some problems that might result in files

notb

eing installed.

« Before installing this release as an upgrade, ensure you create a back-up of your Enterprise Server
configuration. To do this, on the Enterprise Server Administration home page, click Export and then
select Export Enterprise Server configuration and Security Manager definitions. This creates a
backup folder in the c:\programdata\micro focus\Enterprise Developer\MFDS. You can

resto

re the Enterprise Server configuration after installing this release - click Import on the Enterprise

Server Administration home page.

Installing

/e

To instal

te:

If installing Visual COBOL for Visual Studio 2010, check Software Requirements for information
about what and how to install if your machine is not connected to the Internet.

Before installing, check Installation Restrictions and Requirements.

See Installing as an Upgrade first for important information when upgrading an existing installation
of Visual COBOL.

This version of the product is a full install.

| this product:

1. Run the vevs2010_222 _exe (vcvs2012_22.exe when installing the product for Visual Studio 2012
or vevs2013_22._exe when installing the product for Visual Studio 2013) file and follow the wizard
instructions to install the prerequisite software and the product.

f Note:

When the installation has completed, on some editions of Windows you might receive a notification
that Visual Studio 2012 has compatibility issues. This is a Microsoft's known problem. To resolve it,
follow the instructions in the notification for obtaining help online, or download the KB2781514
update for Visual Studio 2012 from the Microsoft Download Center.

If you are installing onto a machine that has an existing Micro Focus product that uses an older
Sentinel RMS License Manager, you might be prompted to remove it and install the Micro Focus
License Administration. By doing this you maintain the existing Sentinel RMS license files while
adding the Micro Focus License Administration. If you are unsure about existing licenses on your
computer or removing the Sentinel RMS License Manager, consult your System Administrator. If
you want to proceed, remove Sentinel RMS License Manager by using Add or Remove
Programs (Windows XP) or Program and Features (Windows Vista or later), and rerun the
installation file.

Trial licenses cannot be used with remote desktop services. If you want to use your product in this
way, please contact Micro Focus SupportLine to obtain a relevant license.


http://www.microfocus.com/DOCS/LINKS.ASP?NX=CTL1

* We recommend that you install any updates for Visual Studio and the .NET Framework that are
available at the Microsoft Download site.

» If you install JDK you might be prompted to install the latest update. The latest update is not
required for use with Visual COBOL but you can install it if you wish.

Visual COBOL Installation Options

To install Visual COBOL you run vevs2010_222 _exe which contains a number of product -msi files
(Windows Installer packages). When run, vevs2010_222 . exe performs some initial system checks then
sequentially installs the .msi files.

Note: The following applies to vcvs2012_22 _exe when installing the product for Visual Studio 2012.

The following applies to vcvs2013_22 . exe when installing the product for Visual Studio 2013.

vevs2010_ 222 . exe can take a number of parameters, enabling you to specify a number of different
types of installation:

* Standard Installation

Format:
vcvs2010_222._exe
Summary:
Full installation including License Manager and Visual COBOL. During installation you can specify
options including the location to which the components are installed.
* Non-interactive Installation

Format:

vevs2010_222_exe /passive

Summary:

Full installation, but the components are installed non-interactively using default options and
directories.

¢ Silent Installation

Format:
vevs2010_222._exe /q
Summary:
Full installation, but the components are installed non-interactively with no user interface, using
default options and directories.
* Modified Silent Installation

Format:

vevs2010_222.exe /q InstallFolder=d:\otherdirectory

Summary:

Full installation, but the components are installed non-interactively with no user interface, and Visual
COBOL is installed to d:\otherdirectory.

To see what parameters you can use, execute the following from the command line:
vevs2010_222_exe /2.

f Note:

* Log files that are created during installation are saved in the folder specified by the TEMP
environment variable. To change the location or name of the files, use the /log parameter on your
setup command line and specify the path and file name, for example: filename /log d:\temp
\log. txt. This creates a log file, named log. txt, in the d:\temp directory.

Installation
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Microsoft Terminal Server

You can use this product with Microsoft Terminal Server but note that a separate end-user license is
required for each user who accesses it, even if the product is running on a single machine. See your End
User License Agreement.

Microsoft Terminal Server is an environment for running multiple instances of a single-user product. It is not
a platform where a single-user product can be made to perform as a multi-user product.

To install onto a terminal server:

* Log on to the physical terminal server with a user ID that has administrator privileges.

* Use Control Panel > Programs (or Add/Remove Programs on older versions of Windows) and follow
the instructions on the screen.

When you install the product on Microsoft Terminal Server or similar terminal software, do not execute
more than one installation at the same time.

When you install Microsoft Terminal server, you must assign a unique port address to each user. Then the
very first time that each user logs into Visual COBOL and starts the terminal server, they should:

1. Select Options > Project > Port address for Web Server.
2. Type in the assigned port address.

This is necessary because the default port address for the Web server is 80. Once this has been allocated
to the first user, when the next user attempts to start the Web server, the software recognizes that this port
is in use and rejects the attempt. Consequently each user requires an individual port address.

Installing from a Server

There are two methods for installing this product on users' machines using a server. You can:

< Copy the product onto the server and then use Setup under control of a third-party software distribution
package, such as Microsoft's Systems Management Server (SMS), to install the product onto multiple
users' machines.

This method of installation and the associated file are not supported by Micro Focus. They are provided
on an "as is" basis and have not been tested in any form. You can use them at your own discretion.

« Install onto the server. Then users run Setup to install from the server onto their own machines.

Both methods give you control of what options the user can install and mean you do not have to send the
installation media to every user, as they install from the server instead.

Windows Compatibility Mode

In Windows Vista and Windows Server 2008, if you have problems starting Enterprise Server instances
using the Micro Focus Enterprise Server Administration HTML GUI, ensure that none of the Enterprise
Server program files are configured to use a Windows compatibility mode. You can check for compatibility
modes by examining the file properties for the program file using Windows Explorer:

1. Open the Properties dialog box for the file.

2. Click the Compatibility tab.

3. Ensure that Run this program in compatibility mode for is not checked.
4

. Click Show settings for all users and ensure that Run this program in compatibility mode for is not
checked.

5. Click OK on both dialogs to update the file properties.

Verify that <i nst al | - di r >\base\bin\mfds.exe is not set to run in a compatibility mode.



« For 32-bit Enterprise Server, check bin\cas*.exe and bin\mfcs.exe
« For 64-bit Enterprise Server, check bin\win64\cas*.exe and bin\win64\mfcs.exe.

After Installing

You are now ready to run Visual COBOL. From the Windows taskbar click Start > All Programs > Micro
Focus Visual COBOL > Visual COBOL for Visual Studio nnnn.

Note: The Start menu is not available on Windows 8 and Windows Server 2012. You use the Start
screen to invoke programs.

Note: For applications created with earlier Micro Focus products or earlier versions of Visual COBOL,
note the following:

Database Access Managed applications using SQL(DBMAN=0DBC) that were compiled in
Visual COBOL 2.1 Update 1 must be recompiled in Visual COBOL 2.2 Update

2.
Existing Application executables that were compiled using earlier Micro Focus products
Applications must be recompiled from the sources using Visual COBOL.
Open !DL” v+, Important: If you are installing this release as an upgrade to Enterprise
Compiler  “%2 peyeloper 2.2 Update 1, after the upgrade you must rebuild any applications that

are compiled using the —zp1 option.

The behavior of the —zp1 option has been reverted to that of versions of Enterprise
Developer earlier than 2.2 Update 1, with an additional correction relating to Char
Varying data items.

The behavior has been restored to that in Enterprise Developer versions earlier than
2.2 where, when compiling with —zp1, all parameters are treated as unaligned. (In
Enterprise Developer 2.2 Update 1, the behavior when compiling with —zp1 was to not
treat parameters as if unaligned).

When using the —zp1 compiler option, all Character Varying data items are now treated
as if unaligned. In previous versions of Open PL/I, for Character Varying data items,
the —zp1 unaligned requirement was applied only to structure members and
parameters.

To illustrate the change, consider the following example:
zptest: proc options(main);
dcl 1 st1,

2 c char,
2 x(4) char(7) var init ("a", "xx", "yyy", "zzzz");

dcl y(4) char(7) var init ("a", "xx", "yyy", "zzzz");
dcl sub entry ((4) char(7) var);
call sub (X);
call sub (y);
end;
sub: proc (2);

dcl z(4) char(7) var;

Installation
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dcl i fixed bin(31);

do i = 1 to hbound(z);
2(i) = X'
end;

end;
Where:

 Forxand z, each char (7) var itemis 7 plus 2 bytes which equals 9 and then
multiplied by 4 equals 36.

« If y were aligned on half-word by default, each array element is half-word aligned
and each equals 10 bytes (9 + 1 pad byte), and the total size equals 40 bytes.

* Atcall sub (X), the calling argument and parameter are matched.

» Atthe call sub (y),they element size (10 bytes) is mismatched against the
parameter z element size (9 bytes) due to —zpl. This is incorrect and causes
unexpected program behavior.

Due to this correction of treating all Char Varying data items as if unaligned when using
—zpl, the size of CHAR VARYING arrays now differs from previous versions of Open-
PL/I. For example:

dcl X(4) char(7) var;

Put skip list (size(X)) /* size is 36 bytes vs. 40 bytes in
previous versions of Open-PL1 */

Please refer to the Start Here and Product Information sections in your product Help. Here, you will find

informat

/e

ion on getting started including tutorials and demonstration programs.
te:

The first release of Visual Studio 2010 has a browser-based help system, Microsoft Help Viewer
1.0, which does not include an index for the locally-installed help. Navigation of the content is only
available using the table of contents and Search and the help contents for the Help system does
not expand and collapse in the same way as previous Help systems.

If you have problems trying to view the Micro Focus help, ensure that the Visual Studio Help
Library is pointing to local help. From the Visual Studio menu click Help > Manage Help Systems
> Choose online or local help and check the | want to use local help button.

Visual Studio 2010 SP1 provides an upgrade of the help system, Microsoft Help Viewer 1.1, which
provides a stand-alone help viewer with an index and a fully expandable table of contents.

If you do not want to install Visual Studio 2010 SP1, you can install some third-party tools that
enable the index or the fully expanding table of contents. For more information, see the topic Help
on Help.

To view the help in Visual Studio 2012, ensure that the Visual Studio Help Library is pointing to
local help. From the Visual Studio menu click Help > Set Help Preferences > Launch in Help
Browser.

For full details of the Visual Studio 2012 Help system, see the locally installed Microsoft Help
Viewer 2.0 Help, which is available from Help menu in the IDE.

On Windows 8 and Windows Server 2012, an issue with Microsoft Help Viewer 2.0 and Internet
Explorer's security being turned on can cause the Help content to be displayed as raw HTML
code. To resolve the issue, you need to turn off the Internet Explorer Enhanced Security
Configuration (IE ESC) for both administrators and users. Check the Microsoft Windows help for
more information on how to do this.



» To view the help in Visual Studio 2013, ensure that the Visual Studio Help Library is pointing to
local help. From the Visual Studio menu click Help > Set Help Preferences > Launch in Help
Browser.

» For full details of the Visual Studio 2013 Help system, see the locally installed Microsoft Help
Viewer 2.1 Help, which is available from Help menu in the IDE.

Repairing

If any product files, registry settings or shortcuts are accidentally removed at any point, you can perform a
repair on the installation to replace them.

To repair your installation on versions of Windows Vista or later:

1. From the Control Panel, click Uninstall a program under Programs.
2. Right-click your Micro Focus product and select Repair.

To repair your installation on older versions of Windows, such as Windows XP:

1. Click Start Menu > Control Panel > Add/Remove Programs.
2. Click your Micro Focus product in the list of installed programs.
3. Click Click here for support information.

4. Click Repair.

Uninstalling

Windows

To uninstall the product, you cannot simply delete its files from your hard disk. To uninstall the product:

1. Log in with the same user-ID as you used when you installed the product.
2. Click Uninstall a program under Programs (or Add/Remove Programs on older versions of
Windows) in Control Panel.

3. On older versions of Windows such as Windows XP, ensure that Show Updates (at the top of the Add
or Remove Programs dialog) is checked, so that any hot fixes or WrapPacks are listed.

4. Select the product and click Remove or Uninstall as appropriate.

When you uninstall, the only files deleted are those that the installation software installed. If the product
directory has not been removed, delete any unwanted files and subdirectories within it using Windows
Explorer.

Note: The installer creates separate installations for Micro Focus Visual COBOL and Micro Focus
License Administration. Uninstalling only Visual COBOL does not automatically uninstall the Micro
Focus License Administration or any of the prerequisite software.

To completely remove the product you must uninstall the Micro Focus License Administration as well.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.

Some registry entries are not removed by the uninstallation process and you need to manually delete
them.

The following folders might not be removed:

e The Micro Focus Product Nane folder in the Start menu - you can delete it manually.

* Y%systemdrive%\Users\Public\Documents\Micro Focus - includes the binaries and the log
files of the samples which you have built.

* %ProgramData%\Micro Focus - includes some data files used by the Micro Focus licensing system.

 %Program Files%\Micro Focus - you can delete it manually.

Installation
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To silently uninstall the product, you need the setup file and you need to execute the following at the
command line:

start /wait install-file.exe /Zquiet Zuninstall

In addition, the following registry entries are not removed. These are created the first time that an
Enterprise Server that has been enabled for performance monitoring starts up:

* Micro Focus Server\Performance\Active Servers
* Micro Focus Server\Performance\PerfiniFile

18 | Installation



Licensing Information
i Note:

» If you have purchased licenses for a previous release of this product, those licenses will also
enable you to use this release.

» The latest version of the SafeNet licensing software is required. See the Software Requirements
section in this document for more details.

« Your entitlement for using this product is governed by the Micro Focus End User License
Agreement and by your product order. If you are unsure of what your license entitlement is or if you
wish to purchase additional licenses, contact your sales representative or Micro Focus
SupportLine.

To buy and activate a full unlimited license

To buy a license for Visual COBOL, contact your sales representative or Micro Focus SupportLine.

For instructions on using the Micro Focus Licensing Administration Tool, see Licensing in the Visual
COBOL help.

To start Micro Focus License Administration

From the Windows Taskbar click Start > All Programs >Micro Focus License Manager > License
Administration.

f Note: On Windows 8 and Windows Server 2012, you use the Start screen to invoke programs.

Installing licenses

If you have a license file

1. Start Micro Focus License Administration.
Click the Install tab.
3. Do one of the following:

N

» Click Browse next to the License file field and select the license file (which has an extension
of .mflic).

» Drag and drop the license file from Windows Explorer to the License file field.

e Open the license file in a text editor, such as Notepad, then copy and paste the contents of the file
into the box below the License file field.

4. Click Install Licenses.

Alternatively, you can install the license file from within the IDE as follows:

Licensing Information | 19
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1. Start Visual COBOL.

Click Help > Micro Focus Product Help > Product Licensing to open the Product Licensing dialog
box.

Ensure | have a full Visual COBOL license is checked.

Click Browse next to the License file field.

Select the license file (which has an extension of .mFlic), and then click Open.

Click Authorize to install the license.

n

o gk w

You should see a dialog box with a confirmation that the licenses have been installed successfully.

If you have an authorization code

Authorizing your product when you have an Internet connection
f Note: This topic only applies if you have an authorization code.

The following procedure describes how to authorize your product using a local or network license server.
The license server is set up automatically when you first install the product.

Start Micro Focus License Administration.

Click the Install tab.

Type the authorization code in the Enter authorization code field.
4. Click Authorize.

w N

If you change the name of the machine running your license server after it has granted licenses, the
licenses stop working.

Authorizing your product when you don't have an Internet connection
y Note: This topic only applies if you have an authorization code.

This method of authorization is required if your machine does not have an Internet connection or if normal
(automatic) authorization fails.

Start Micro Focus License Administration.

Click Manual Authorization on the Install page.

Make a note of the contents of the Machine ID field. You will need this later.
Do one of the following:

HwbdhpPE

« If your machine has an Internet connection, click the SupportLine Web link in the Manual
Authorization Information window.

< If your machine does not have an Internet connection, make a note of the Web address and type it
into a Web browser on a machine that has an Internet connection.

The Micro Focus SupportLine Manual product authorization Web page is displayed.
5. Type the authorization code in the Authorization Code field. The authorization code is a 16-character
alphanumeric string supplied when you purchased your product.
Type the Machine ID in the Machine ID field.
Type your email address in the Email Address field.
Click Generate.
Copy the generated license string (or copy it from the email) and paste it into the box under the License
file field on the Install page.

© N
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10.Click Install Licenses.

To obtain more licenses

If you are unsure of what your license entitlement is or if you wish to purchase additional licenses for Visual
COBOL, contact your sales representative or Micro Focus SupportLine.
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New Features in Visual COBOL 2.2 Update

Visual Studio Support

Visual COBOL provides enhancements in the following areas:

« Call Hierarchy - support for the Call Hierarchy window has been enhanced and it now shows types and
members across the entire solution.

» Debugging enhancements - includes enhanced support for the Autos windows for native and managed
COBOL, support for querying EBCDIC data in managed code, and support for the standard visualizers
for data items and groups in native COBOL.

« Expanded Copybook View (only supported in Visual Studio 2012 and Visual Studio 2013) - now
supports Intellisense, collapsing and expanding of outlining regions, and code snippets.

* Find All References - you can now configure the scope of the Find All References command. The
default behavior is to search for references in the current COBOL project and now, you can enable Find
All References to search for matches in all managed COBOL projects that are part of your solution.

* Net Express Project Import wizard - now includes a number of usability enhancements.

* Run-time configuration - you can now use the application configuration file, Application.config, in
native COBOL projects to set all run-time tunables.

Character set enhancements

The following character sets, available using the MFCODESET environment variable, have been enhanced
or added in this release:

e Thai Extended (0066) - new

» Korean (0082)

« Simplified Chinese (0086)

« Traditional Chinese (0886)

There are also a number of double-byte character sets that are now capable of mixed single-byte and

double-byte character conversion; see the definition of MFCODESET in Environment Variables in
Alphabetical Order for more information.

Code Analysis

Visual COBOL can produce the following reports:

« Dead Code - finds unreferenced items or any piece of code that can't be reached during execution.

« Unreferenced Data - finds any data items that are not explicitly referenced in the Procedure Division of a
program.

« Undeclared Procedures - finds any procedures that are referred to but not defined.

« Copybook Structure - displays the hierarchy of any copybooks defined in a program.

« Program Statistics - provides general information, such as number of source code lines, number of data
items, and size of data items.

New Features in Visual COBOL 2.2 Update 2



« Unexecuted Procedures - finds any procedures that are defined but not referred to.

Database Access

The following new features have been added as part of database access support:

COBSQL Pro*COBOL You can now select and configure the ProxCOBOL COBSQL
Support preprocessor for compiling COBSQL applications on the SQL tab
in the project's properties.
KEEPCOMP The new KEEPCOMP directive resolves COMP/COMP-5 issues
Directive with Oracle applications on little-endian platforms.
DB2 This release introduces a new DB2 ECM compiler directive option, GEN-HV-FROM-

GROUP, that generates host variables for all elementary data items when a multiple-level
group variable is used in a FETCH or singleton SELECT DB2 statement.

OpenESQL  This version provides the following new OpenESQL features:

SQL Server Support for SQL Server 2014.
SQL compiler  The following are new SQL compiler directive options:
directive
options DETECTDATE=SERVER Resolves host variables alignment with
column data types in an SQL table.
GEN-HV-FROM-GROUP  Generates host variables for all
elementary data items when a
multiple-level group variable is used in
a FETCH or singleton SELECT SQL
statement.
Sample The following native COBOL SQL sample applications are new with
applications this version:
Get Diagnostics Demonstrates how to use GET DIAGNOSTICS
EXEC SQL calls to get diagnostic information
from various DBMSs.
LOB Data Types Demonstrates how to INSERT and SELECT
LOB data in a native application using various
DBMSs.
XA switch Restriction: This feature applies only when the Enterprise Server feature is
modules enabled.

The Oracle and SQL Server XA switch modules are now compiled with one source file
rather than two.

Micro Focus COBOL enhancements
The following enhancements have been made to Micro Focus COBOL.:
e The following phrases have been added to the XML GENERATE statement:

« NAME
« TYPE
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+ SUPPRESS
» The following intrinsic functions have been added:

 ULENGTH

« UPOS

« USUBSTR

* USUPPLEMENTARY
 UVALID

« UWIDTH

External Security Facility (ESF)

The Enterprise Server External Security Facility (ESF) now supports caching the results of some security
queries. This can improve the performance of enterprise server instances and of the MFDS when they are
configured to use external security.

To enable caching, you need to set non-zero values for the Cache limit (maximum size of the cache) and
Cache TTL (Time To Live, or how long before a cached result expires) settings on the MFDS Security tab,
the Default ES Security tab, or on the Security tab for an individual enterprise server. (Currently, the
cache settings for Security Managers have no effect; you need to set cache parameters on one of the three
Security pages mentioned earlier.)

For more information, see http://supportline.microfocus.com/examplesandutilities/doxygen/caching.html.

New tunables
The following tunables have been added in this release:

reduce_java_signals This tunable specifies the options that are passed to a JVM when mixing Java and
COBOL.
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Known Issues

Refer to the Known Errors and Restrictions topic in the Product Information section of your product Help.

In addition, note the following:

ASP.NET

COBOL
Watchpoints

Documentation

Enterprise
Server

It is not possible to run ASP.NET Web Sites or Web Services on a production machine
(one that has Micro Focus COBOL Server installed) without an additional setup. This
is because the production machine does not contain development tools such as the
COBOL Compiler. To workaround this, you need to do the following steps:

1. Compile the site prior to deploying it using the Publish Web Site command in
Visual Studio.

2. Edit the .asmx file of the Web service project or the .aspx file of the Web site and
delete the Language=""COBOL"" statement.

3. Edit the Web.config file with a text editor and delete the line which contains:
<compiler language=""COBOL". ..

4. Ensure that a .NET Server license is installed using Apptrack.

The debugger ignores a COBOL watchpoint that is hit if there is no statement following
the statement that modifies the data on which that watchpoint is set.

* In Visual Studio 2012, clicking Help > Micro Focus Product Help > Product
Documentation results in the message "Cannot find requested topic on your
computer”. If you see this message, click Micro Focus Visual COBOL 2.2 for Visual
Studio 2012 in the Contents tab to display the documentation as expected.

» If you install Visual COBOL for Visual Studio 2012 and its documentation is not
available in the Microsoft Help Viewer, perform the following steps:

1. In Visual Studio 2012, click Help > Add and Remove Help Content.

2. Choose the Manage Content tab.

3. Check the Disk radio button, then navigate to the folder containing the Visual
COBOL for Visual Studio 2012 documentation. By default, this is C:\Program
Files (x86)\Micro Focus\<product name>\help.

Select helpcontentsetup.msha and click Open.

In the content list, click Add next to the Visual COBOL entry.

Click Update.

Click Yes on the User Account Control and Microsoft Help Viewer 2.0 dialog
boxes to enable the update to continue.

The documentation for Visual COBOL for Visual Studio 2012 is added to the
Microsoft Help Viewer.

i Note:

This problem only occurs if you install Visual COBOL for Visual Studio 2012
while documentation for Visual Studio 2012 is being downloaded or updated,
which typically happens when you install Visual Studio 2012 or run it for the
first time.

No ok~

» The Historical Statistics Facility may generate incorrect records for SSTM-enabled
enterprise servers.

Known Issues
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Expanded
Copybook View
(in Visual Studio
2012)

ICETOOL
Emulation

Installation

Native COBOL

Resource
Adapters

Visual Studio
IDE
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*  When you add a COPY statement in a COBOL program and then show it in
Expanded Copybook View, the line for the copybook statement is read-only. If you
then perform an Undo in the COBOL program, the COPY statement is removed
while the contents of the copybook is still shown in the program.

* Replace All does not work inside the Expanded Copybook View

» For copybooks with file extensions that are not traditionally associated with COBOL
you must first add the file extension to the list of known copybooks extensions in
Tools > Options > Text Editor > File Extensions before you can show them in
Expanded Copybook View.

ICETOOL emulation for managed code is not available in this release.

» Before installing this release as an upgrade to an existing installation of the
previous version 2.2 of the product, you must uninstall any HotFixes of 2.2. This is
to avoid some problems that might result in files not being installed. This is required
only on Windows.

» Before installing this release as an upgrade, ensure you create a back-up of your
Enterprise Server configuration. To do this, on the Enterprise Server Administration
home page, click Export and then select Export Enterprise Server configuration
and Security Manager definitions. This creates a backup folder in the c:
\programdata\micro focus\Enterprise Developer\MFDS. You can
restore the Enterprise Server configuration after installing this release - click Import
on the Enterprise Server Administration home page.

* When installing this product for Visual Studio 2010, if you already have Visual
Studio 2010 Isolated Shell with Service Pack 1 (SP1) installed, you might
experience problems with starting Visual Studio after the installation. This is a
Microsoft issue relating to the Integrated Shell (installed as part of the Micro Focus
product installer) overwriting some Visual Studio SP1 components. To resolve the
issue you need to repair Visual Studio 2010 SP1.

On Windows XP, when building a native COBOL application in Visual Studio, a dialog
may pop up with error "Unhandled exception at 0Oxc0006866 in cobol.exe:
0xC0000005: Access violation reading location 0xc0006866)". This is caused by
Symantec antivirus runtime protection. To resolve this, you need to apply the following
fix from Symantec: http://www.symantec.com/business/support/index?
page=content&id=TECH97280&locale=en_US.

Trying to deploy the local resource adaptor mFcobol-localtx. rar to WebLogic
may fail with a ClassCastException. To work around this issue, you need to deploy
mfcobol-xa. rar first, then need to undeploy this file and deploy the local one,
mfcobol-localtx.rar. If there are issues deploying using the WebLogic GUI, you
can use the command line. If there are issues with this as well, try reducing the length
of the command (for example, by moving the file to a location with a shorter path).

* In the properties of a managed project, the Application page currently allows you
to select any of the static methods in the application as a Startup object. This is
incorrect. You should always set only the first static method or the program name
as a Startup object in order for the project to build.

» Using Call Hierarchy locks the source files currently opened in the editor. To work
around this problem, you need to trigger a syntax check - for example, by making a
small change to one of the open files.
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Significant Changes in Behavior or Usage

This section describes significant changes in behavior or usage. These changes could potentially affect the
behavior of existing applications or impact the way the tools are used.

The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).

* Compiler

» Compiler Front-end
« Documentation

¢ J2EE Connector

Compiler
Back to the list

* When using the HOSTRW directive with the mainframe dialect, Report Writer will now produce the full
range of ASA control characters and will emulate mainframe print files.

2697615 (1094527)

Compiler Front-end
Back to the list

» Fixed Binary (p<=7) is now an 8-bit, signed, 2's complement binary integer by default.

Documentation

Back to the list

* The default setting for the MFALLOC_PCFILE environment variable has changed; the default is now set
to Y, which means that when cataloguing a file that has a DCB attribute of DSORG=PS, a physical file is
created for it if one does not exist. Previously, the default was set to N, which meant that a file was not
created.

2697571 (1094370)

J2EE Connector
Back to the list

« The listSystem.properties file in package com.ibm.ctg.client was missing documentation for some
sections.

(606556)
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Resolved Issues

The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).

e .NET Compiler

.NET ESQL Support

« .NET Run-Time System

e Adis

e CAS (COBOL App Server) General
e CAS Admin Console

e CAS Security

e CAS XA Switch modules

« CCITCP/IP

e Compiler

* Codeset Support

» Data Tools Converter

« Data Tools Layouts

» Documentation

» Enterprise Analyzer Integration
* ES Cluster

» File Handling: External File Handler
¢ MF Communications Server

e MF Directory Server

e MFA Server

¢ MFA SyncMon

« MFBSI
« MFIO
* NCG

¢ OO Run-Time System (32-bit)
¢ Run-Time System

e Setup Issues

e SQL: Cobsql

« SQL:DB2 ECM

e SQL: OpenESQL

« Unassigned

¢ Visual Studio IDE

*  Web Service Client

e XML syntax support runtime

.NET Compiler
Back to the list
e Comparisons between PIC N or PIC G items and ALL hex-literals are now working correctly.

2795393 (1096266)

« The CURRENT-DATE function, using reference modification with an implied length (e.g. FUNCTION
CURRENT-DATE(3:)), now behaves as expected when compiled to managed COBOL.

2788009 (1095691)
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In Managed COBOL only, an unreferenced elementary field of an "IS EXTERNAL" data item would not
be initialized by the INITIALIZE verb, even though the containing group item was referenced. This is
now working correctly.

2787385 (1095405)

The performance of the .NET Compiler has been enhanced. Previously, programs that included multiple
pointers and comp-5 items with value clauses could take a long time to load. The use of the XML
preprocessor could lead to this condition, since it generates data of this type.

2784731 (1095278)
Correct behavior is now being displayed when the INITIALIZE statement is used on DBCS data, where
the initializing literal is a single-byte alphanumeric.

2784714 (1095079)

Exponentiation with a literal exponent of 2 (or multiple of 2) on a signed field is now working as
expected. In previous versions of the product, such an operation could lead to invalid code.

2784503 (1095063)

Compatibility of SPZERO with native COBOL code has been improved in the following two cases: 1) If
a-9 = space (where a-9 is defined as pic 9(n) DISPLAY) With SPZERO on, this comparison will now
always yield a false result. 2) Move a-x to a-9 (where a-x is pic x(n) and a-9 is pic 9(n)) In the case
where a-x contains spaces, this move will now result in a-9 containing zeroes.

2676477 (1093768)

.NET ESQL Support
Back to the list

When using OpenESQL for ADO.NET, the first execution of a statement for SQL Server no longer locks
the varbinary host variable sizes.

2791617 (1095920)
The OpenESQL pre-compiler sometimes generated incorrect code if a PIC X(n) VARYING host variable
was used in a COBOL JVM project.

2787380 (1095934)
The managed SQL run-time system now correctly handles variable string lengths for both 49-level
COMP fields and 49-level COMP-5 fields.

2782088 (1094793)

The OpenESQL native ODBC wrapper used in managed applications would sometimes incorrectly set
index past the end of table before moving information to the table which resulted in a COBOL subscript
error.

2780447 (1094665)

.NET Run-Time System

Back to the list

In managed code, multiple processes using the same input file in a SORT statement will no longer get
intermittent open failures.

2790155 (1095759)

Adis
Back to the list

When using X"AF" function 81, screen attributes are now inherited correctly.
2782580 (1094878)

Resolved Issues
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« Using an ACCEPT statement followed by a display of an OUTPUT RIGHT item and an ERASE EOL
item no longer causes a corruption of a screen section.

2695444 (1093924)

CAS (COBOL App Server) General
Back to the list
e Using the INPUTMSG parameter for the XCTL and LINK commands is nhow working correctly.

2790518 (1095805)
« On user syncpoint, a 500-error no longer returns to the client if the application did not issue a WEB
SEND.

2780958 (1094671)
* When linking to a program with a channel, the current channel was not always honoured.

2779977 (1094556)
» Enterprise Server is not longer sending a FREEKB to the terminal at the end of a task when there is
more work pending for the terminal.

2691707 (1093544)
« You no longer receive an intermittent signal 11 in MFCS during shutdown.

CAS Admin Console
Back to the list

« When starting an enterprise server instance, the location of the work files may differ depending on
whether the instance was started using a browser or from the command line. See the documentation for
"system directory" in the topic "Server Instance Properties General".

2660616 (1090612)

CAS Security
Back to the list

* The es-ldap-update.cmd script has been updated for the Visual COBOL product line. The script is used
to install a sample set of security definitions when LDAP-based security is used with Enterprise Server.

CAS XA Switch modules
Back to the list

e EXEC SQL RESET CONNECTION has been updated and is used to drop Global Temporary Tables at
the end of tasks.

2693269 (1093613)
« EXEC SQL SYNCPOINT has been updated and now correctly handles ON COMMIT actions for
DECLAREd global temporary tables.

2682648 (1093611)

CCI TCP/IP
Back to the list

e CCITCP client connections could intermittently fail on some platforms due to transient errors in the
TCP/IP stack. CCITCP is now more aggressive at detecting and retrying client connections under these
conditions. This primarily affects COBOL Web services clients, some Enterprise Server command-line
utilities, and Fileshare clients.

Resolved Issues



2794263 (1096355)
INT and CSO modules that use the Casfile APl can now successfully connect to SSL-secured
Enterprise Server listeners.

2696022 (1094318)

Compiler

Back to the list

Programs with a mainframe dialect that contain a paragraph declaration that is not preceded by a period
and that is previously referenced now compile as expected.

2793046 (1096112)
Complex table VALUE syntax is now working as expected.

2792013 (1095954)
Compilation no longer hangs when REPLACE and COPY REPLACING is active and the source code
has multiple lines ending in a comma.

2791425 (1095905)
READ and WRITE statements with the RM filehandler for files defined with the "RECORD VARYING
FROM 0 TO ..." syntax now behave as expected.

2785986 (1095385)
An INSPECT CONVERTING statement on a subscripted sliding item now executes as expected.

2785328 (1095244)
Setting the LINE-COUNT(2) Compiler directive on a project no longer causes the IDE to crash during a
background syntax check.

2784751 (1095114)
Data items with DBCS characters which are defined as SQL data types are now processed correctly.

2783799 (1094976)
The OSEXT and COPYEXT directives now work with quoted names (with or without spaces).

2780350 (604653)
Compiling programs that use both the "WITH DEBUGGING MODE" and "IS INITIAL" clauses now
produces correct object code.

2779266 (1094498)
Programs that use an external report file now execute as expected.

2698699 (1094352)
The performance of the syntax constructs "SET ADDRESS OF .. TO ADDRESS OF ..." when using the
AMODE compiler directive has been improved.

2697051 (1094174)
A MOVE of 'ALL <alphanumeric literal>' to a numeric display item is now correctly emulated under
DIALECT(RM).

2648551 (1089534)
The IDE now correctly indicates the location of errors in multi-program source.

2541308 (1081744)
Using Watch/Quick Watch on a data item with subscripts, where one of the subscripts is also
subscripted, now produces the correct results.

2463792 (1075281)
A program that exceeds the system limit of 254 DETAIL groups for a report now receives an appropriate
error message "COBCH1692S Too many DETAIL groups specified for report".

2458349 (1096071)
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Codeset Support
Back to the list

* The offset of input segments is now calculated correctly. In order to apply the fix, you must regenerate
the MFS source.

2695463 (1093948)

Data Tools Converter
Back to the list

« Converting a data file using record layouts will now report an error if a field within the selected record
layout exceeds the length of the data file record being converted.

2699617 (1094446)

« The GUI data file converter no longer terminates data item conversion prematurely when using a record
layout with an ODO data item.

2692803 (1093839)

Data Tools Layouts
Back to the list

« Creating a record or a segment layout file no longer fails when the COBOL names contain double-byte
characters.

Documentation
Back to the list

e The documentation for the MFBSI CTF trace option has been corrected in the online help. It now reads:
mftrace.comp.mfbsi.emx#all = true

2693323 (1093631)
« The description for the MULTI-NESTED topic under DB2 Compiler Directive Options was incorrect.

2783274 (1094953)

* The topic about the ILSMARTLINKAGE Compiler directive in the product help now includes information
about the get_Reference() method (JVM COBOL) and the .Reference property (NET COBOL) that the
classes and types generated with ILSMARTLINKAGE produce. If you pass such a class or type as a
parameter to a program that receives it "by reference”, you need to use the "by reference" object by
specifying the get_Reference() method or .Reference property, respectively. This returns an object that
encapsulates the ILSMARTLINKAGE parameter so it be used with a method that is declared as "by
reference”. You also need to use get_Reference() or .Reference with the RunUnit:Call() method.

2779516 (1094514)

* The setup file installs the product and any missing third party software, and will install the Java 7
Update 27. This information is now included in the Software Requirements section of the product help.

2785427 (1095199)

« The setup file installs the product and any missing third party software, and will install the .NET
Framework v4.0. This information is now included in the Software Requirements section of the product
help.

2672774 (1095057)

Enterprise Analyzer Integration
Back to the list
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« Anissue with the DISPLAY ... LINE statement being unable to process expressions has been fixed.

ES Cluster
Back to the list

« In a clustered configuration of Enterprise Server, on some platforms, MFCS could crash during startup
of an enterprise server instance due to attempting to process communications with the cluster manager
before initialization was complete.

File Handling - External File Handler
Back to the list

< An automatic close of a file opened in a container no longer causes a rollback.

2790362 (1095956)

« Previously, a file could be left with its integrity bit set to transactional if a process included a mix of
transactional and non-transactional opens and the last close of the file was a non-transactional one.

2785682 (1095657)
« The transaction log now correctly shows the timestamp for the prepare, commit and rollback operations.

2784948 (1095162)

« If a VSAM file is opened for an OUTPUT in a RANDOM/DYNAMIC access mode, the file virgin state is
changed to a non-virgin even if no records are written to it. If the file is opened for an OUTPUT in a
SEQUENTIAL access mode, its virgin state is retained.

2781975 (1094779)

 The MFALLOC_PCFILE environment variable now works as expected. Previously, it would be bypassed
when the ES_ALLOC_OVERRIDE environment variable was also specified.

2692290 (1093977)

e During Open OUTPUT of a VSE VSAM reusable file, with DISP=0LD, the file is no longer reset; the file
is opened in EXTEND mode.

2638640 (1089073)

MF Communications Server
Back to the list

» Certain Enterprise Server administration actions such as notifying a running enterprise server of a
security update could cause MFCS to hang.

2784219 (1095045)

MF Directory Server
Back to the list

* The Enterprise Server Administration no longer terminates when trying to display a list of users
registered on an external Security Manager.

2788461 (1095505)
* The 64-bit MFDS is now able to read and write XML configuration data.

MFA Server
Back to the list

« This release provides a fix for abend 0C4 in XDBWWWMO.

Resolved Issues
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MFA SyncMon
Back to the list

* Previously, PDS members without ISPF statistics caused an error message "Input string was not in a
correct format" when processing the timestamp. Now the current time is used. SyncMon2 also
downloads the entire PDS every time.

2783738 (1094996)

e The product now displays a useful error message and not an exception when a user specifies an illegal
output.

« Removing a rule from the SM2 dialog no longer causes other rules to be removed from the dialog.

MFBSI
Back to the list

» Support has been added for the Control-M $JULIAN/$GREG/$WEEK# functions using the Control-M
expression or variable parameters.

2698531 (1094301)

MFIO
Back to the list

» Specifying a leading ";" in an environment variable containing a file path no longer results in the file not
being found.

2693286 (1093707)

NCG
Back to the list

« Using a "MOVE alphanumeric-item to numeric-item" statement in programs generated with the
CHECKNUM directive now correctly results in a Run-Time System error 163 (invalid numeric data)
message.

2796191 (1096340)
* Building programs that use DIALECT(RM) and that contain calls with more than eight parameters no
longer fails with a RTS 114 error.

2788746 (1095583)

* Anissue with statements of type "compute edited-item = expression"”, where expression evaluates to a
value larger than the value that edited-item can store, and so truncation is required, has been fixed. This
only affected Intel x86 32-bit generated code when the HOSTARITHMETIC Compiler directive was set.

2782400 (1094841)
» Compiling code that contains alphanumeric intrinsic functions with very long parameters could
previously result in an error at generate time. It now generates successfully.

2782306 (1094942)
< A bug in the MOVE statement where the source item is S9(15)V99 COMP-3 and the target item
S9(8)V9(9) comp-3 has been fixed.

2697129 (1094607)
* The performance of arithmetic with COMP-3 items on the 390 platform has been greatly improved.

2683340 (1092877)
* Programs that include 8-byte comp/comp-5 variables in a PERFORM loop termination condition, with
the OPT Compiler directive specified, now compiles successfully in 32-bit mode.
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An issue with the code generated for alphanumeric moves on Intel x86-32 when the OPT(4) Compiler
directive was specified has been fixed.

You no longer receive an RTS 114 error when processing invalid directives.

You no longer receive an RTS 200 error in debuggable generated code (.gnt) programs compiled with
the amode(31) Compiler directive.

A problem with setting breakpoints on some EXEC SQL statements has been fixed.

OO Run-Time System (32-bit)
Back to the list

Native object-oriented programs with multiple methods that use local-storage data now execute as
expected.

Run-Time System

Back to the list

You can now use a configuration file that has a spacey filename to start Audit Manager as a service.

2785459 (1095200)

The debugger now displays correctly the content of non-ASCII characters in programs compiled with the
CHARSET(EBCDIC) Compiler directive.

2782246 (1094947)

In some situations, the processing of a Run-Time System error in an Enterprise Server container could
cause the container to hang or crash. This has been fixed.

2690883 (1094783)

Setup Issues

Back to the list

The mfsupport permissions have been modified so that any user with access to the product can now
run mfsupport.

2781319 (1094713)

SQL: Cobsql
Back to the list

COBSQL now correctly processes source lines that only contain a single character at column 72.

2781493 (1094727)
COBSQL now correctly processes SQL statements with continuation lines.

2781299 (1094716)

SQL: DB2 ECM
Back to the list

A new directive option, DB2(ALEBRA), has been added to the DB2 ECM preprocessor to prevent
ASCII/EBCDIC translation of host variables used in SQL statements. DB2(ALEBRA) is applicable only
when using the EBCDIC character set and the Alebra Remote DB2 Access software.

2789897 (1095736)

Programs using SQL TYPE AS CLOB compiled with host variables were flagged with COBCH0233S
Compiler error because the reserved word "AS" is not supported in mainframe dialects such as
Enterprise COBOL. The DB2 pre-compiler now resolves this by adding "AS" as a valid reserved word.

2698988 (1094584)
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While editing the source code in the IDE during syntax checking, the DB2 pre-compiler sometimes
generated incorrect error messages for DECLARE CURSOR statements if they were defined in the
WORKING-STORAGE section when the DB2 BACKGROUND PARSING option was set to NONE.

2698133 (1094267)

SQL: OpenESQL
Back to the list

36 | Resolved Issues

The OpenESQL preprocessor incorrectly terminated a host variable lookup resulting in a COBES0109
error.

2795391 (1096265)
Using a SQL Server fast forward cursor with an ODBC driver that does not support MARS caused a
rollback when the cursor was closed.

2793798 (1096126)
Applications migrated from earlier products that used the tokens ON and ROW_NUMBER as column
names in SQL statements were compiling with errors.

2793301 (1096088)

The OpenESQL preprocessor produced a compilation error for EXEC SQL select ... INTO
<TableName> ... END-EXEC.

2792715 (1096102)

The OpenESQL runtime for ADO.NET was incorrectly returning the native database error in
SQLERRD(1).

2790152 (1095758)

A problem fetching decimal columns using OpenESQL for ODBC in locales where the decimal point is
not '.' has been fixed. In addition, to optimize performance for the majority of ODBC applications, the
default setting for SQL(DECDEL) has been changed from NODECDEL to DECDEL=LOCAL. Use an
explicit SQL(NODECDEL) directive for Windows applications that change the effective locale
dynamically at runtime.

2788986 (1095766)
The insertion of values larger than 8000 characters from a PIC X host variable into a SQL Server
VARCHAR(MAX) column caused an error.

2787574 (1095428)
Some valid ODBC SQL expressions caused the OpenESQL preprocessor to issue errors when it
encountered a 'BY" token.

2787068 (1095429)
Valid SQL "PARTITION BY" clauses caused compiler errors when using OpenESQL.

2786991 (1095386)

Performance of the OpenESQL runtime system for ODBC required improvement when fetching
character data.

2785410 (1095165)

The OpenESQL preprocessor generated invalid code resulting in undefined ECM error code 302 when
an array host variable was mixed with regular host variables in a parameter list in the EXEC SQL CALL
statement.

2785284 (1095354)
A memory leak occasionally occurred when multiple prepares of the same dynamic SQL statement
existed in the OpenESQL JDBC runtime system.

2784039 (1095123)
The OpenESQL preprocessor incorrectly interpreted the SQL CONCAT character as DBCS when using
SQL(CONCAT=124) for the CONCAT character, resulting in compilation error.



2783615 (1094981)

* When compiling for ODBC, the OpenESQL preprocessor now generates an error message,
COBES0123, when it encounters an EXEC SQL statement that contains a host or indicator variable that
uses a subscript. Subscripts of this type are not supported in ODBC.

2781022 (1094686)

e The GEN-HV-FROM-GROUP SQL compiler directive option intermittently caused truncation of SQL
VARCHAR data type occurrences.

2780748 (1094649)

e SQL(CHECK) caused compilation errors when compiling source programs containing DBCS characters
in column names. Programs containing DBCS characters in column names that were compiled using
SQL(NOCHECK) caused runtime errors.

2780185 (1094588)

* The GEN-HV-FROM-GROUP compiler directive option has been added to the OpenESQL preprocessor
to support the selection of multiple levels in a group item. Specify SQL(GEN-HV-FROM-GROUP) when
compiling to generate host variables for each elementary definition in a group record.

2699622 (1094395)
e OpenESQL for JDBC did not correctly open insensitive cursors.

2699442 (1094415)

« OpenESQL Assistant was inconsistently inserting the query function in the "B" area for queries and
column 8 for other code.
2697908 (1094190)

« The OpenESQL preprocessor sometimes incorrectly defined host variables when an indicator variable
array was used with an SQL statement.
2696332 (1094052)

* You no longer receive errors when parsing Oracle INTERVAL expressions.

2694071 (1094337)

« A problem that prevented a COBOL stored procedure from being called from a nested trigger has been
fixed.

2690749 (1094042)

« The restriction that program names in an application must be unique in the first 24 characters in order
for OpenESQL to handle cursors correctly has been increased to 30 characters. This is to restore
backwards compatibility with earlier Micro Focus products.

2685901 (1093808)

« HCOSS now provides better control for ODBC applications that use data that: o0 Uses the DATE and
TIME formats specified by SQL(DATE) and SQL(TIME) o Is stored as character data in the database
You can now do any of the following: o Specify host variable types to use with DETECTDATE. o Set the
ODBC runtime to determine parameter data types by querying the server (this option uses additional
runtime overhead). o Tag string literals in SQL statements with special SQL comments that specify the
type of literal. With this option, literals tagged with *#CHAR*/ are not reformatted when
SQL(DIALECT=MAINFRAME) is set.

2685625 (1093540)

Unassigned
Back to the list

< A channel created by a program invoked by a CALL statement is now visible to the programs running at
the same level.

2698335 (1094225)
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Visual Studio IDE
Back to the list

*  When debugging a native COBOL program and querying an alphanumeric data item, you now have
access to the visualisers to view the data.

2785437 (1095170)

« A problem where WPF event handler methods were not created in the code when using Visual Studio
2013 Update 2 has been resolved.

2782479 (1094867)
< All run-time tunables can now be set using the Application.config file in the Visual Studio IDE.

2779522 (603989)
» The SQL page in the project's properties now handles SQL(NOINIT) correctly.

2697905 (1094189)

« Using the left button of the mouse to click in the editor margin below the end of a source file no longer
causes an exception to occur.

« The Create New Enterprise Server dialog no longer loses track of the location of the server templates.

(604449)

» After installing or updating the product, the options in Tools > Options > Text Editor > Micro Focus
COBOL are now set correctly.

» Previously, using the call hierarchy would lock some source files until the next time the IDE performed a
syntax check.

« If you used the OF or IN phrase with a COPY statement, it was not possible to show the corresponding
copybook in the Expanded Copybook view or open it using the Open Document command. This fix is
not available for copybooks stored in library files (where you have used the COPYLBR Compiler
directive).

» If the Call Hierarchy is requested for the same named item in more than one program both items are
now displayed.

« When navigating from the results in the Call Hierarchy window, the caret is now correctly positioned at
the beginning of a method name, paragraph name or section name.

« If a copybook contains multiple consecutive COPY statements, showing those consecutive copybooks
no longer causes Visual Studio to display an exception message.

* When stepping from a program into another program and directly into a copybook referenced using
COPY... REPLACING, the expanded copybook view now correctly shows the contents of the copybook
with the replaced values.

« If you opened a source file in more than one view and if you then attempted to debug that file, the
debugger could sometimes fail to step into the expanded copybooks view and could sometimes show
other unpredictable behaviour.

« When adding existing files to a native mainframe subsystem project, the Add Existing Item dialog now
shows the correct set of files.

Web Service Client

Back to the list

« Namespaces not declared on the schema root, i.e. declared either with an element declaration or on the
WSDL root, will now be processed properly and no longer ignored.

2583853 (1085102)

XML syntax support runtime
Back to the list

« The HTMLPP preprocessor now handles copybooks with filenames longer than eight characters
correctly.
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2783315 (1095092)
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Updates and SupportLine

Our Web site gives up-to-date details of contact numbers and addresses.

Further Information and Product Support

Additional technical information or advice is available from several sources.
The product support pages contain a considerable amount of additional information, such as:

* The WebSync service, where you can download fixes and documentation updates.
« The Knowledge Base, a large collection of product tips and workarounds.
« Examples and Utilities, including demos and additional product documentation.

To connect, enter http://www.microfocus.com in your browser to go to the Micro Focus home page.

y Note: Some information may be available only to customers who have maintenance agreements.

If you obtained this product directly from Micro Focus, contact us as described on the Micro Focus Web
site, www.microfocus.com. If you obtained the product from another source, such as an authorized
distributor, contact them for help first. If they are unable to help, contact us.

Information We Need

However you contact us, please try to include the information below, if you have it. The more information
you can give, the better Micro Focus SupportLine can help you. But if you don't know all the answers, or
you think some are irrelevant to your problem, please give whatever information you have.

e The name and version number of all products that you think might be causing a problem.

e Your computer make and model.

* Your operating system version number and details of any networking software you are using.
* The amount of memory in your computer.

« The relevant page reference or section in the documentation.

« Your serial number. To find out these numbers, look in the subject line and body of your Electronic
Product Delivery Notice email that you received from Micro Focus.

On Windows, if you are reporting a protection violation you might be asked to provide a dump ( -dmp) file.
To produce a dump file you use the Unexpected Error dialog box that is displayed when a protection
violation occurs. Unless requested by Micro Focus SupportLine, leave the dump setting as Normal
(recommended), click Dump, then specify a location and name for the dump file. Once the dump file has
been written you can email it to Micro Focus SupportLine.

Alternatively, you might be asked to provide a log file created by the Consolidated Tracing Facility (CTF) - a
tracing infrastructure that enables you to quickly and easily produce diagnostic information detailing the
operation of a number of Micro Focus software components.
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Creating Debug Files

If you encounter an error when compiling a program that requires you to contact Micro Focus SupportLine,
your support representative might request that you provide additional debug files (as well as source and
data files) to help us determine the cause of the problem. If so, they will advise you how to create them.
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Disclaimer

Disclaimer

This software is provided "as is" without warranty of any kind. Micro Focus disclaims all warranties, either
express or implied, including the warranties of merchantability and fithess for a particular purpose. In no
event shall Micro Focus or its suppliers be liable for any damages whatsoever including direct, indirect,
incidental, consequential, loss of business profits or special damages, even if Micro Focus or its suppliers
have been advised of the possibility of such damages. Some states do not allow the exclusion or limitation
of liability for consequential or incidental damages so the foregoing limitation may not apply.

Micro Focus is a registered trademark.

Copyright © Micro Focus 1984-2014. All rights reserved.
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